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1ELECTRAy safe internetbank usage Yy ATTENTIONS FOR COMPANIES

1 Always open a new browser for internet based banking services. Enter your internet
banking ID and password only on the login page, accessible by you from
www.raiffeisen.hu website entered in the address bar of your browser. Do not use any
link to navigate to the browser because if you are not in the right place, you might get
phishing attacked by adding your identification and password.
1 NEVER use your Raiffeisen internetbank when you get the link through SMS, email or from
a social media side, not even when you got it from a trustful partner.
T /i YOA 1TiY HOUYOH AiiivYyCioboit ACU YCOdUoCéonm

%) https://www.raiffeisen.hu

dC 1T1Y OGd|l HYGOH OdiiT1dé &ao0CYy oC 1
The authenticity of the webpage can easily be checked by the certificate.

You can get more information from the IX. chapter of the Electra user manual.

i Take care of and never tell anyone your SMS code that you get from the bank to activate
your internet bank, your password and PIN code what you specified after you activated
the service. Do not make any note about your identification data (to your computer or to
your mobile device) that by falling into unauthorized hands allows access to banking
services in your name. When your internet browser asks for permission to keep your
password, do not accept it.

1 Do not download unknown origin or unknown application (for example Anydesk,
Teamviewer) to your phone or your computer and do not allow remote access to your
device for unauthorized person. Your bank will not ask you for this in connection with a
virus protection or any other legal issue.

1 Always read carefully what you get in SMS from your bank.

We draw your attention to scams disguised as executive or business messages.
¥T0OH AOCU dé HOAEe oH |iYC 1TiY OdegACtOH eo0CACO«
invoice or transferring money from the company's account.

Fraudsters call the employee on the phone or send him an e-mail, pretending to be a high -

level manager of the company or a well -known supplier.

o017 Td TiY OCHTGI OT10dCH GYOYoLYU¢ 1TiY OdegAcCto
account managed by the fraudsters.

Be careful if:

Your supplier sends you an email that their previously used bank account number is being
changed and they request that their invoices have to be settled to another bank account
number.

A leader representing your supplier gets in contact with you who you never worked with
before.

They ask you to work in a different method.

Be careful when you get an email or a phone call:

Always attentively check the email address when you manage confidential information or
transfer money.

When you have doubts about a payment request, ask for a competent colleague to help.
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Do not open any suspect link or appendix which comes with an email.
Be especially careful when your log in to your personale¢ Ao a AOOdi C1 e Gdé
computer.

The financial information is a value and treatment of it needs increased caution:

If there is doubt about a call or in connection with an email, ask for confirmation through a

different channel.

Use public or other costGY o ¢ Of GHYU UAT AOAHY eédG Oi YOAoCé
establish its authenticity.

In case of downloading Electra customer terminal and automated terminal (Hypex) you
should take especial care of the following instructions:

 %di Hidiau dcat Ud| CadAu oe 1TiY OdegACt OH Odc

virus protection.
T Ifyouinstall it on a hard drive, it should be encrypted if possible.
1 Do not use an open WiFi connection while using electronic banking channels (for
YeAegay GYHT AI GACi ¢ OAep¢d idivYa 1idiHgdIt o
1 Updates of the operating system, used on the computer, must be up to date.

1.1Internet banking risk arising from authorized representative status

Our customers may hold their own bank account with our Bank as individuals and may also
be granted the right to dispose over the bank account of another individual/corporate
Customer as a representative registered with the Bank.

The person registered with the Bank as an authorised representative can view and manage
all bank accounts, whether their own or those of another account -holding customer
(principal), using their unique identifier, after logging in to their own Internet Ban k.

If the unique code or Internet banking identifier and password, which is also used by
the representative in the banking systems, is obtained (lost, stolen, disclosed to an
unauthorised person):

1. deposit held in the account holder's bank account may be at risk; and

2. in the case of a representative registered for more than one of the Bank's
customers, the deposit held in the accounts of all the account holders concerned
may be at risk.

For the above reasons, it is very important that you use your codes, unique identifiers
and passwords to access the Bank's systems carefully and diligently, and never,
under any circumstances, disclose them to anyone else. Please make sure to inform
your representatives of this!

Please only grant a power of attorney, i.e. give someone else the right to dispose over your
bank account, bearing in mind the particular risks described above.

You can find more detailed information on the Online Fraud Information page.
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If you find that you have been a victim of fraud, please call your relationship manager or
other bank contact immediately, or our bank's Fraud Prevention team, which is available 24
hours a day, every day of the week, on the following phone number: + 36 1 486 5380
Please pay extra attention to your banking and company details.

2 First Login, Password Chang e

You can access Electra Internetbank from the home page of the www.raiffeisen.hu website by
clicking on the Electra icon.In all cases the login page is in the unitary Raiffeisen login screen, which
you can find here: (https:/sso.raiffeisen.hu/sso/XUl/#login/ ) In the login screen of Electra
Internetbank, please enter your Electra User ID, then click on the Next button.

Login

Login

Please enter your ID (8 digit Direkt ID or Electra User ID), then click on the NEXT button.

COMPANY:USER Next

A User ID: the identifier provided in the Electra Request Form
The system will look after the User ID and the connected authentication method. You should have
selected this in the Electra Request Form in your Userdata. According to this it will asks for data

which required for identification.
The login process will be continuing by the following authentication methods:

Login with password + SMS authentication method

In the password fieldyoué | AT YCT YG tdi G \déoC uAHH| dGU¢ T
button.

Login

Login

COMPANY:USER ] I ........ @ Request code

A Login Password : your Electra password received from the Bank in SMS or on a plastic card
to be used for your first login .
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An SMS code will be arriving to your phone which will be needed for the authentication.You
Hi diau YCiYG TioH OdUuy oCid 1iY Goéiil eovauU 71
the Electra Internetbank starting page.

Login

Login

Please enter your SMS code that was sent to your mobile number in a text message

,,,,,,,, |

000-12345678 I [ Cancel } Login

COMPANY:USER

If you would like to choose another login mode, please contact your relationship manager.

Your login password must be changed on a mandatory basis after your first login. To do so,

bdi T ALY 1d YCTiYG Aé¢AoC tdi G ¢daus gAHH|I dGU 11
adéoCt ¢ ACU 1 ALY T1Ldgin@assivord salectedcby ydursels Which can be
validated by clicking on the OK button.

Login with Token authentication method

Turn on your signiture device (token) and sign in with your pin code, after you are done with
that , you should type in the sequence of numbers you see in the Token input field.

You should type in your response code into the Token code field, then click on the Login
button.

Login

Login

Please enter the token code

31776556 ® I

COMPANY:USER ]

Please enter the response code to this token input.

{ Cancel ] Login

........ | @

If you would like to choose another login mode, please contact your relationship manager.

About the Token commissioning you can read more here: 7.5First usage of Token

Login with VICA mobilapplication authentication method
Login to your ViICA application with the password, specified during registration, on your mobil

phone.
After you have loged in, the next page will be a Raiffeisen Electra confirmation message.
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Login

Login

Please start the VICA application.

COMPANY:USER ] Cancel J

If you would like to choose another login mode, please contact your relationship manager.

¥7TY €YHHAHAéY o COai,th¥idantfication rditb&r@t th€ date 6f the login.

In this screen if you clickto T 7 Y 2! § § Gd Lthk SystenOWillil6t yoC i to the Electra

MCT YGCYT OACAOGH gAéeve¢ Aei YG 17i AT tdi OAC OQadHAy
About the Vica mobil application commissioning you can read more here:7.9Signing Orders
with VICA

User Banning Rules

In the event that the user enters an incorrect password, they will receive a warning
message. After 3 incorrect attempts, the user will be banned

3 Administration

3.1 Create New User

1. In the Administration/New User  menu, enter in the Alias field the new user alias

chosen by yourself, then click on the OK button.

A Group Code: filled automatically, and is identical with the first part (the part
OYedGY 1Y Ga@serdbuded upon login

A ShortNames 17 O0H | 0aa OY 1iY HYOdCW g A& Hdiicr
User ID

A Login Password: your first Electra password received in SMS or on a plastic card,
which must be changed after the first login
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| Main page | Magyar | Last Login: 2015 ock: 09:57

g Raiffeisen e
A\ BANK B 3

Electra Internetbank User: User  Client: *Logout
» Quitk menu New User - Enter ID data
* Reporting

Group code P

* Sent Packages

* New Order Short name

Manage Orders
New Template

» Manage Templates

Manage Partners
v Administration

» User Information

> New User

» Modify User

» Delete user

» Generate Initial Password
» Delete Error Points

Settings

> Help

> LogoLt

2.1 @7 YG 17 0H¢ VY CRuVrame,Uskr Idéndifler &nd Mdbi@ Bhone number
in the data form of the new user.

P Raiffeisen P | Main pog avar | Last L 015,10.01, 1¢ | ki 09145
BANK & searchmenu v

Electra Internetbank User: User  Cliant: »Logout

> Quick menu New User (creation)

* Reporting

N enurackege: scheduled date of dispatch |201510.01 |
* New Order

S anaoal=riars User identifier MY TRA

» New Template Full name

> Manage Templates Type

' Manage Partners Electra alia

~ Administration Number of failed login

» User Information Falled signature:
> News User
» Modify User

Allowed/Suspended ]

» Delete user User address

» Generata Initial Password

HU Hungar v
+ Delete Error Points INGRKY
» Settings
City
+ Help
Address
* Logout
Mobile phone number @
Phone number @D
E-mail
KUT 1D

>Cancel  >immediate dispateh > Add 1o package

3. Select the Interface for Login Authentication.

A Authentication tools

Authentication tool uUsable Data
Login 1 Login

A Login authentication

Interface Authentication tool
~ - > Add
Electra
~ Corporate netbank ‘e authentication
Corporate mobilebank
Enabled interface Signature authentication tool
~ No permission to sign - > Ada
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4. Select the Authentication tool  for Login Authentication.

4 Authentication tools
Authentication tool Usable Data
Login password Login

A Login authentication
Interface Authentication tool

Corporate netbank v v » Add

Login password
A Enabled interfaces / Signature authentication

Enabled interface Signature authentication tool

v No permission to sign v > Add

5. Select the Enabled Interface

~ Authentication tools

Authentication tool Usable Data

Login password Login

~ Login authentication
Interface Authentication tool

Corporate netbank v Login password v > Ada

~ Enabled interfaces / Signature authentication
Enabled interface Signature authentication tool
v No permission to sign v > Add

Electra
A Corporate netbank
Corporate mobilebank

6. Click on the Signature Authentication Tool drop down menu and select No
permission to sign since the useris not entitled to approve payment.

A Authentication tools

Authentication tool Usable Data

Login password Login

A Login authentication
Interface Authentication tool

Corporate netbank v Login password v > Add

A Enabled interfaces / Signature authentication
Enabled interface Signature authentication tool

Corporate netbank v No permission to sign v > Add
No permission to sign

7. If necessary, givelnput and/or View right(s) to the user. By Default , a user has Enter
and View rights. (A new user may not be granted signature right!)
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- Authentication tools

Authentication tool Usable Data
Login

A Login authentication

Interface Authentication tool

Electra v Login password v
~ Enabled interfaces / Signature authentication

Enabled interface Signature authentication tool

Electra v No permission to sign v
A Account authorizations

Account no. FCY : St Default® Record ® view® Sign®

Default authorizations m} O

120 8 HUF  Open (2]

120 6 EUR  Open 2]

120 3 UsD  Open (2]

120 7 EUR  Open ™

120 4 HUF  Open ™

120 1 HUF Open [

120 8 HUF Open ™

120 6 HUF  Open (2]

120 3 EUR  Open 2]

120 0 EUR  Open v

120 7 HUF Open ™

120 7 HUF  Open ™

120 4 HUF  Open ™

120 1 HUF (2]

120 2 HUF Open

120 9 EUR  Open 3]

8. For special services z if necessaryz give Input and/or View rights to the user, then
after acceptance of the statement, click on the OK button. (The user may not be
granted signature right!)

W Raiffeisen
PN BanK
Electra Internetbank

Select package

(@ Please choose a package for the order,

9. In the Manage Orders /Manage Packages menu, HY & Y

> Immediate dispatch > Add to package

a

User: User  Client:

Package name
COMPANY:NEWUSER 20151002 15:35.03

and click on the Sign Selected Packages button.

Raiffeisen Electra Internetbank - User Manual
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* Quick menu Manage Packages

<licl < Beil < 21 < I8¢

> Sign seloctod packages > Dolote signatures from seloctod packages

Sond solocted packages > Doloto seloctod packages

10.¥d HYCU A CcYl 2HYGS dGUYG 1d 1iY ./Sado HY
Selected Packages button.

3.2 Generate Initial /New Login Password

1. In the Administration/Generate Initial Password menu, click on the name of the
user who needs a new login password.

2. Click on the Immediate Dispatch button.

3. In the Manage Orders /Manage Packages ¢ YCi ¢ HYA&aAYOT TTY ¢DY
uAHHA] dGUS dGUY G gignSeladtedPackades bdtton ta sigiYthe file.

4. Select the signed file, and click on the Send Selected Packages button to send the file.

3.3 Modify User

1. In the Administration/Modify User ~ menu, click on the name of the user you wish to

modify.
2. Carry out the desired change, and click on the Add To Package button.
3. In the Manage Orders /Manage Packages ¢ YCi ¢ HYavOi 17i1Y CbdUoe

click on the Sign Selected Packages button.
4. Select the signed file, and click on the Send Selected Packages button to send the file.

3.4 Delete Failures

1. In the Administration/Delete Error Points menu, click on the name of the user who
needs the new login password.

2. Click on the Add To Package button.

3. In the Manage Orders /Manage Packages ¢ YCi ¢ HY&avYOir 11Y C5Yay
order, and click on the Sign Selected Packages button to sign the file.

4. Select the signed file, and click on the Send Selected Packages button to send the file.
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3.5 Daily and Transaction Payment Limits y for more info please click  here..

4 Using Multiple Clients

If you have rights in respect of several clients, you can select from these using the dropdown list
in the upper right corner of the screen (before the Logout button).

5 Reporting

In the Bank Information menu the data and notifications disclosed by the Bank (e.g. account
balances, account statements, exchange rates, interest rates, other terms and conditions, etc.)
may be viewed.

5.1Account Overview
In the Reporting/Account  Overview menu, you can view the actual balance of your

bank accounts, and the rights belonging to these. By clicking on the line of the relevant account
you can display all data of the account in a new window.

-’Y“ Raiffeisen Help | Main page | b st Login: 2015 .10 ; —
[P\ BaNK & varch e )
Electra Internetbank user: user  Client: »Logout

» Quick menu Account Overview

~ Reporting

2 You can customize the animation of pop-up windows and tables
» Account Overview »Setting

» Account Balance

7 = You can add your favourite functions to the Quick Menu
npleted Transactions > Setting

@ You have 14 order package(s) are pending submission.
a >click here to manage your orders.
» Account Statement

» PDF Statement AR T Time of query: 2015.10.02. 15:30:21

1 360 161,83 EUR
Total balance per currency 3 586 939 745,41 HUF
» Cash Pool Interest 1079 179,06 USD
» Deal Information

Account number . Account name Available amount Cey
* SentPackages -

120 8 K 1 386 480 860,54 HUF >
* New Order 120 6 K 976 111,94 EUR >

120 3 K >
* Manage Orders

120 7 K >
* New Template 120 4 K >
+ Manage Templates 20 L b 2 2

120 K 8 117 696,68 HUF >
* Manage Partners 120 6 H 1 386 480 860,54 HUF >
+ Administration 1204 El 14 531,21 EUR >

120 o P 366 186,99 EUR >

Settings 120 7 5 150 683 734,67 HUF >

> Help 120 7 G 652 957 500,67 HUF >

120 4 N 47 748,44 HUF >
» Logout

120 1 K 0,00 HUF >

120 K 0,00 HUF >

120 o o 12024 s s

5.2 Account Balance

In the Reporting/Account Balance  menu, you can see the balance of your bank accounts
summarised by currencies, i.e. your actual balance. By clicking on the line of the relevant
account you can also inquire transactions in progress, as well as account information
concerning other deposit a nd credit transactions.
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¥ Raiffeisen H in pa agyar | Last Lo i5.10 39:01 | Time lock: 09:57
BANK & search menu .

Electra Internetbank User: User  Client: >Lagaut
* Quick menu Account Balance Titne of queryi2015.10.02. 15:39:25 ¢
v Reporting

1360 161,83 EUR
Total balance per currency 3 586 939 745,41 HUF
1079 179,06 USD

» Account Overview
> Account Balance

Account number Account name Available amount Cey
120 8 K 1306 480 960,54 HUF >
120 3 K 976 111,94 EUR >
120 K s >
120 7 K >
120 4 K >
120 1 K >
120 8 K >
* Sent Packages 20l = = =
* New Order 120 3 El >
120 o P 366 186,99 EUR >
» Manage Orders 5
120 7 G 150 683 734,67 HUF >
» New Template 120 7 G 652 957 500,67 HUF >
e me 120 4 N 47 748,44 HUF >
120 1 K 0,00 HUF >
2 D (PRl 120 K 0,00 HUF >
» Administration i ol 2 3l 2 £
120 2 3 HUF >
> settings e = B HUF >
* Help
» Logout

5.3 Completed Transactions

In the Reporting/Completed Transactions menu, you can view the transactions concerning
your bank accounts that were booked on that day.

Raiffeisen S | Main pag st Lagin 2¢ 39:01 | Time 09:51
P\ BANK & earchmens :
Electra Internetbank User: User  Client: A
comsen accourer |
> Quick menu Completed Transactions Time of query:2015.10.02. 15:40:06
~ Reporting
+ Account Ovarviaw Account t number Cey Account t name
»Account Balance 120 8 HUF K >
g i 120 8 ER K >
120 13 uso K >
120 17 EUR K >
120 14 HUF K >
120 i HUF K >
120 8 HUF K >
s 120 3 HUF  H >
» Cash Pool Balance 120 13 EUR  E >
» Cash Poal Interest T i S =
» Deal Information
120 17 HUF G >
* Sent Packages 120 17 HUF G &
2 ! >
S Plew Orclar 120 4 HUF N
120 i HUF K >
> Manage Orders 120 2 HUF K >
> New Template 220 = Gl ) 2
120 12 HUF L >
» Manage Templates 120 ) EUR v S

* Manage Partners
+ Administration

» Settings

» Help

> Logout

5.4 Account History

In the Reporting/Account History  menu, select the account and the time interval (no longer
than 2 consecutive months) which you want to see. and click on the OK button . You can print
your account history by clicking on the Printicon £ in the upper right corner of the screen or
export the data in csv or xIs format by clicking on save icon. [

You may view the account history of those accounts only in respect of which you have view
right (which is automatically implied in the signature right).
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» Completed Transaction Opening balance
s Mot Closing balance
» Pending Orders

Time interval: 20
» Notification Type
» Cash Pool Balance Forint stutal

» Cash Pool Int

B jtvos
» Deal Information

» Sent Packages

» New Order

* Manage Orders

Forint atutala
iy Temolate Forint atutalas

* Manage Templates Forint atutalas

Forint at
» Manage Partners T
» Administration Forint dtutalas
itve

» Settings
> Help

)-dtve
» Logout

Forint atut

Forint atutals

Forint atutal
Kamat
Kamat

Kamat

1538 683 120,24

25, - 2015.10.02,

Date Contra account Partner / Comn Amount
015,00 120 B 16 10 HUF >

! o 14 917,¢ >
0 3 964,00 HUF >

5 M
01¢ o 16 667,00 HUF >
2015 7 R 1234,00 HUF >
20150930, 120 & T 15 000,00 >
2015,00.30. 120 2 1 >
2015,00.30. 120 o >
2015.09.30 >
2015.09.30 >
2015,09.30 >

s > o IS

If you click on any booked Account History item, you can view the details of the transaction as

well.

5.5
You may

Raiffeisen

AP Raiffeisen
BANK

Electra Internetbank

Help | Main page | Magyar tL 1 15:39101 | Time lock: 09157

& Searchmenu v

User: User  Client; » Logout

» Quick menu

* Reporting

» Account Overview ction type

Details of the transaction o

633+ Forint Atutalds

»Account Balance Amount UL
ompleted Transactions Initiator

+ Account History Name o

» Pending Orders
e e tate ant Debit account number 120

* PDF Statemant Narrative A20040000,0F 07!

» Search in statements
s FX Rates

» Notifications

cash Pool Balance
Cash Pool Interest
Information

Value date

Transaction 1D

» Sent Packages
> New Order

* Manage Orders

> New Template

» Manage Templates
* Manage Partners

> Administration

» Sattings

> Help

> Logout

Pending Orders

view your current suspended orders in the Reporting/Pending Orders

A Raiffeisen
AN BANK

Electra Internetbank

2015.00.25

2015.00.25

BBKI 4l 5

>Back

menu.

Help | Main page | Magyar | Last Login: 2015.10.01. 15:39:01

Q search menu v

User: User  Client: EL1005¢ ot

* Quick menu

* Reporting
» ACOURE Ovarview Account number
> Account Balance 120
> Completed Transactions 120
> Account History 120
> Pending Orders o
> Account Statement e
> PDF Statement
> 5earch in statements 15
> FX Rates 120
> Notifications 20
> Cash Pool Balance 120
> gas:w]p?al Ir\lterest =
eal Information e
+ Sent Packages 120
» New Order 120
120
> Manags Orders 120
» New Template 120
120
* Manage Templates 120

» Manage Partners
» Administration

> Settings

* Help

> Logout

Electra Internetbank -

Pending Orders

Tirme of query:2015.10.02. 15:43:00 [

Currency - Account name
8 HUF >
6 EUR K >
3 usp K >
7 EUR K >
e HUF K >
i HUF K >
8 HUF K >
6 HUF H >
3 EUR 3 >
0 EUR P. >
7 HUF G >
7 HUF G >
4 HUF N >
i HUF K >
2 HUF K >
15 HUF M >
2 HUF u >
L] EUR H >

User Manual (20.12.2024)

15



5.6 Account Statement

In the Reporting /Account Statement menu, enter the period for which you need account
data, and click on the OK button.

You can access the latest account statement by clicking on the Download Latest Account
Statement button. You can print and export (e.g. MT940, csv, or xIsa downloaded statement
by clicking on the icons in the upper right corner of the screen (beside the date of the
statement).

Raiffeisen Help | Main page | Magyar | Last Log 10.01. 15:39:01 | Time 00:32
[P\ BANK B wan men. )
Electra Internetbank User: User  Client: »Logout

> Quick menu Account Statement Statement date:2015.10.01. = 5

~ Reporting
1201 8 HUF K
K

RBH-BUDAPEST BRANCH
eri 0000168
2015.10.01. - 2015.10.01.
1541871 693,63
0,00
536 769,00
1542 408 462,63

rest Contra account Partner / Comment Amount
» Deal Infarmation 120 0 o 10 000,00 HUF >
> Sent Packages 120 1 U 25 000,00 HUF >
120 15 ) 3 594,00 HUF >
» New Order 120 16 B 4431,00 HUF >
» Manage Orders 120 n T 14 008,00 HUF >
120 18 ] 3945,00 HUF >
& o R 120 13 K 1 133,00 HUF >
* Manage Templates 120 " B 7 570,00 HUF ¥
120 15 s 3 236,00 HUF >
» Manage Partners
120 0 e 13 856,00 HUF 5
» Administration 120 0 8 13 856,00 HUF >
» Settings 120 0 T 7 110,00 HUF 2
120 4 o 25 000,00 HUF >
> Help 120 I U 17 811,00 HUF 3
> Logout 120 13 B, 2,00 HUF >
120 15 K 25 219,00 HU
120 8 M 22 000,00 HU Back

5.7 Authenticated Electronic (PDF) Account Statements

In the Reporting/PDF Statement menu, select the account and the period for which you need
a statement, and click on the OK button. You can print and export the authenticated
electronic account statement so generated by clicking on the icons in the upper right corner

of the screen.

5.8 Search in statements

In the Reporting/Search in statements  menu, you can retrieve transaction shown on the
AObGdi Cci HT AiyevycCi Ot §gAGI CYGOH CAecy AcCcu AdOdai C

¥ Raiffeisen

BANK Q Search manu
Electra Internetbank User: Client: - Viewet
» Quick menu Search in statements

Transaction type Partner’ s name

Partner” s account number Marrative
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The result of searching (Important!!! Marked Od&te n this screen means statement date. )

Electra Internetbank User: Client: v »Logoat
» Quick menu Search in statements
* Reporting

Search criteria
» Account Overview

Account Balance Transaction type Debit Partner’ s name

» Accou I
Search interval: 2018.06.19. - 2018.06.19. Amount

» Value day balance

4 Partner” s account number Narrative
» Completed Transactions
» Account History
*Pending Ovders Megjelenitett tételek 5 Kihagyott tételek: 0
» Account Statement
» PDF Statement
» Search in statements 3

Act vand d Type Partner” s account number Partner / Comment Amount
» Active standing orders

? Group transfer order " 2018.00-19. A11111111 201806180002 7,00 HUF >

» FX Rates E

Nkl -oreign currency 5 -1 906,15 HUI
> Notifications il 2018.06.19. EUR 6,00 1906,15 HUF >
RERSRES Fotwon asTency 2018.06.19. EUR 5,00 1588,46 HUF >
» Forward Value-dated payment v SN

Payment Charge, commission  2018.06.19. HUF 1.906,15 Charge, commission 1391,95 HUF >
» Collections Charge, commission  2018.06.19. HUF 1,588,46 Charge, commission 417584 HUF >
» Initiate Recall Payment
» Cash Pool Balance
» Cash Pool Interest > Back

» Deal Information

5.9 Standing Orders

You may view, create, modify or delete your standing orders in the Reporting/Active
standing orders menu.

5.10FX Rates
In the Reporting/FX Rates menu, enter the date in respect of which you wish to view

foreign exchange rates, and click on the OKbutton. You can print and export the foreign
exchange and currency rates so displayed.

5.11Notifications

In the Notifications option, you can access the status reports belonging to the multiple
and postal orders you have sent to the Bank, additionally notifications of other direct
debit orders.

3 Multiple transfer and collection orders (CS-| ¥ " ¥2 | ¢ 59¥]| ¥! UAo &t
DETSTA summary report)

3 Authorisation for direct debit (FELHAC, FELHAP, FELHOK, FELHKI)

3 Postal payment orders

3 Postal money orders (OCR 31,0CR 32)

3 Collection order based on a letter of authorisation and of an official transfer

order and of writ of payment (CAD -Collection Advice To Debtor, CRE
Collection Response To Creditor)

In the Reporting/Notifications menu, enter the date in respect of which you wish to
download notifications, and click on the OK button. In order to view the details of the
notifications, click on the relevant item. You may as well print and export data.
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E Raiffeisen 1 ]
BANK &/ search menu =
Electra Internetbank user: User  Client: TP

+ Quick menu C5_STATUS message Date of advice

AL1111111

201500240002
201509240005
a5

Accan| S 0 ( 0,00 HUF )
Rajeccad Kems 999 999 { 999 999 999 999,00 HUF )

* FX Rate No. st - clientID Gira reference number Status
+ Motifications

+ Sant Packages

+ New Ordar

* Manage Orders

* New Template

* Manage Templates
+ Manage Partners
* Administration

+ Sattings

+ Help

* Logout

5.12Blocking amount

You may create or delete blocked amount in the Reporting/Restraints  menu.

WA Raiffeisen 2
BANK ] Seorch moou v

Electra Internetbank User Client v »Logout

» Quick menu Restraints Time of query:2016.11.07. 08:25:12

* Reporting
unt number
Al accounts

A 1200 4 HUF
Identifier Blocking start Blocking end Blocked Amount Comment Transaction date and tin
001 2015.07.09. 2899.99.99. 32 568,59 GPP . 2015.07
002 2015.07.09. 2015.07.09.

15.07.09.

004 2015.07.09. 2015.07.09.

» Restraints 201
2016

» Fe

008
013
014
015
* Sent Packages 017
* New Order 018
019 05.0
» Manage Orders
020 016.02.05,
> Croato restraint

* New Template 021 2016.05.09.

5.13Forward Value -dated payment
In the Reporting/Forward value -dated payment menu, enter the date in respect of which
you wish to view payment, and click on the OK button. You can delete the payment or change

the value date of the payment.

5.14Handling of mandates

Youmay submit, modify or delete your mandates in the
Reporting/ Collections/Authorizations  menu.
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Electra Internetbank User: Client: v »Logout

» Quick menu Direct debit authorization Time of query:2016.07.11. 11:28:09

* Reporting

Account number
» Account Overview

Al accounts v
> Account Balance
» Completed Transactions
» Account History ~120 HUF
» Pending Orders
» Account Statement Service company " s name validity start Validity end Value limit Status
* POF Statement 8 2016.04.15 2016.04.28, 100 000,00 Rogzitett v
> Search in statements R 2016.05.06. 2016.05.26 10 000,00 Régzitett v
Hpcil sy crier R 20160506, 20160513 110 000,00 Rogttet <
» FX Rat
2016.04.15 2016.04.26 100 000,00 Rogzitett v
» Notifications
PR 2016.04.15 2016.04.26. 100 000,00 Rogzitett v
Forward Value-dated u 2016.04.25 2016.05.19. 1 000 000,00 Rogzitett v
- u 2016.04.15, RoOgzitett v
U 2016.05.06 Torolt v
» Authorizations R 2016.04.25 100 000,00 Rogzitett v
» Pending Direct Debit R 2016.05.06. 2016.05.27. 1 000 000,00 R&gzitett v
1Epcked Direck Davolt M 2016.05.06 2016.05.12 10 000,00 Rogzitett v
> Initiate Recall Payment
» Cash Pool Balance
A 12001008-00297010-00100006 HUF ELBA TESZT
» Cash Pool Interest
» Deal Information .
Service company* s name validity start = Validity end Value limit Status
» Sent Packages P 2012.04.21 Rogzitett v
P 2016.04.15 Torolt v
» New Order
Hansge Orders > New authorization

* New Template

5.15Pending Direct Debit

In the Reporting/Collections/Pending Direct Debit menu, you can view your direct debit
waiting for processing.

5.16Blocked Direct Debit

In the Reporting/Collections/Blocked  Direct Debit menu, you can view your blocked direct
debit due to lack of mandate. You can submit mandate for processing of blocked direct debit.

5.17Initiate Recall Payment

You may view or submit a call back for your sent payment in the
Reporting/Collections/Initiate Recall Payment menu.

* Reporting

A, Time interval: 2016.04.04. - 2016.04.29.

> Account Balance
> Completed Transactions

< Account number
» Account History

All accounts v
» Pending Orders
» Account Statement
» PDF Statement A 120 HUF
» Search in statements
> Active standing orders Partner” s account number Partner” s name Amount Narrative
» FX Rates HU72 5 3 742,00 HUF 3257/2011/186 sz. szla. v

> Notifications
Arrival time: 2016.04.12. 13:01:59

» Restraints :
Description: Kimené/belsé HCT forint utalds

» Forward Value-dated

Payment > Call back
» Collections
> Initiate Recall Payment HU90 2 a 111,00 HUF 1030 v
» Cash Pool Balance HUS7. 0 P 1 000,00 HUF v
» Cash Pool Interest e R R &
> Deal Informati
DashliovTision HUS7 o P 1 000,00 HUF v
» Sent Packages HUS7 0 P 1 000,00 HUF - - - v
HUS7 0 P 1 000,00 HUF - - - v
» New Order
HUS7 0 P 1 000,00 HUF v
* Manage Orders HU97 2 R 1 242,00 HUF - - - v
= v
. HU97 2 R 1242,00 HUF
HU97 9 R 1.234,00 HUF gj v
' Manage Templates HU11 0o 3 1,00 HUF - - - v
S hanage Patoars HU71 0 4 6 446,00 HUF oasdhoefo v
HUG9 0 si 500,00 HUF asdasdasd v
tAdministration HU90 2 b 15 000,00 HUF asdasd v
» Settings HU02 6 R 1.000,00 HUF asdasd v
HU02 6 R 2 000,00 HUF 13423 ~
> Help N
HUS7 0 1250,00 HUF KORPS199612345 123456789012 >Back
» Loaout PP Yo Y Sy R
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5.18 Cash Pool Balance

If you use the Cash Pooling service, the table shown in the Reporting/Cash Pool Balance
menu includes a client and group identifier filter, as well as supplementary information and
the download date. In the table, you can always see the accounts belonging to the selected
client and group identifier.

5.19Cash Pool Interest
If internal interest allocation is also part of the Cash Pooling service, then you can inquire

such information by clicking in the Reporting/Cash Pool Interest menu on the Download
button.

5.20 Deal Information
In order to inquire the major data of active deposit and credit transactions belonging to the

selected account, select in the Reporting/Deal Information menu, then click on the OK
button.

5.21Deposit

Unique Deposit

Once you have agreed the condition of your cash deposit with your Relationship Manager,
approve your deposit order.

In order to authorize your cash deposit, select in the Manage Orders/Manage Packages
then click on the Take over button.

Electra Internetbank User: Client: e +Logoat
+ Quick menu Manage Packages
' Reporting
» Sent Packages Filter
? New Order
* Manage Orders
Total 0 selected »Select all »Negative salection » Selact none
» Manage Packages (10)
* Import File E.© A L - Package name Order type Pcs. - Sched. Send Date Tatal
» Manual package generation [ G 16/06/02 15:29:39 HUF Transfer 1 2016.06.02. 5111 111,00 HUF ¥
» Send message for signers [ El 34.8LC Custom deposit 1 2016.05.31 500 000,00 HUF ¥
El 36.8LC Custom deposit 1 2016.05.10. 8000 000,00 HUF  ~
' New Template
v El 43.BLC Custom deposit 1 2016.04.27. 1000 000,00 HUF +
' Manage Templates O El 42.BLC Custom deposit i 2016.04.27 1 000 000,00 HUF  ~
» Manage Partners ¥4 El L5.BLC Custom deposit il 2016.04.26. 1000 000,00 HUF  ~
El 10.8LC Custom deposit 1 2016.04.26. 2 000 000 000,00 HUF %
* Administration O =] 57.8LC Custom deposit 1 2016.04.20 100 000 000,00 HUF ¥
+ Settings [ # El 53.8LC Custom deposit 1 2016.04.20. 100 000 000,00 HUF  ~
[ v El 18.8LC Custom deposit 1 2016.04.20 1000 000,00 HUF ¥
' Help El 74.BLC Custom deposit 1 2016.06.02. On common area v
' Logout

» Take over

After taking over your cash deposit you can View, Authorise or Delete it.
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Electra Internetbank User: Client: v »iogont

» Quick menu Manage Packages

* Reporting

+ Sent Packages Filter |

New Order

* Manage Orders
Total 0 selected ,

all ) Negative selection »

» Manage Packages (11)
ort File E.. A L Package name Order type Pcs. - Sched. Send Date Total

» Manual package generation 16/06/02 15:29:39 HUF Transfer 1 2016.06.02 5111 111,00 HUF v
» Send message for signers & 74.8LC Custom deposit 1 2016.06.02. 30 000 000,00 HUF ¥
& 84.8LC Custom deposit 1 2016.05.31 500 000,00 HUF v
* New Template
El 86.8LC Custom deposit 1 2016.05.10. 8 000 000,00 HUF v
* Manage Templates 7/ &l 43.8LC Custom deposit 1 2016.04.27 1 000,00 HUF v
1 5 eposi 2 4.27. 0 ,00 HUF v
» age Prees & Custom deposit 1 016.0 1 000 000,00 HU
Va =) Custom deposit 1 26 1 000,00 HUF v
* Administration ] Custom deposit 1 4.26 2 000 000 000,00 HUF v
» Settings & Custom deposit 1 20 100 000 000,00 HUF v
/ E 53.8LC Custom deposit 1 2016.04.20. 100 000 000,00 HUF v
*Help s ] 48.8LC Custom deposit 1 2016.04.20. 1000 000,00 HUF v
? Logout Account number: 12001008-00118590-00100009 HUF SPAR KFT CS
> View > Delete > Dolotesignatures >  Send Package > Put to common area

After approving your cash deposit, click on Send Package button.

» Quick menu Manage Packages

» Reporting
Filter

* Sent Packages
» New Order

* Manage Orders

Total 0 selected »Select all » Negative selection » Select nane
» Manage Packages (11)
+ Import File E.. A I Package name Order type Pcs. - Sched. Send Date Total
R Hianusl ecane g naration [ Gi 16/06/02 15:29:39 HUF Transfer 1 2016.06.02 5111 111,00 HUF v
» Send message for signers ] EL 174.8LC Custom deposit 1 2016.06.02. 30 000 000,00 HUF %
[m] [ '84.8LC Custom deposit 1 2016.05.31 500 000,00 HUF v
» New Template
(] EL 186.BLC Custom deposit 1 2016.05.10. 8000 000,00 HUF  ~
> Manage Templates [ v EL 143.8LC Custom deposit 1 2016.04.27 1000 000,00 HUF
i tones =] £ 142.81C Custom deposit 1 2016.04.27 1000 000,00 HUF  ~
[ Vi El 115.8LC Custom deposit 1 2016.04.26. 1 000 000,00 HUF ¥
ERACkiR Ao m] EL 140.8LC Custom deposit 1 2016.04.26. 2 0DO 000 000,00 HUF ¥
e =] & s7.81C Custom deposit 1 2016.04.20 100 000 000,00 HUF ¥
(] 4 EL '53.BLC Custom deposit 1 2016.04.20. 100 000 000,00 HUF v
=y O v EL '48.BLC Custom deposit 1 2016.04.20 1000 000,00 HUF
» Logout Account number: 1200 LKFT CS

T N FE P

In the Sent Packages/Order menu, you can view the status of your cash deposit by clinking
on Bank status inquiry  button.

Raiffeisen Help | M gvor | Last Logins 2016.07.11. 12144123 | Time locks 09158

BANK &, Search menu v
Electra Internetbank User Client: v *Logeut
» Quick menu Order status
* Reporting

+ Sent Packages Search criteria

patum: 2016.06.01. - 2016.06.30. Order type:
» Order Status
» Search Transaction
* New Order Package name Order type Submitted Pcs. Total
EL 07.8LC Custom deposit 2016.06.01. 13:44:29 1 40 000 000,00 HUF  ~
+ Manage orders i
EL 06.BLC Custom deposit 2016.06.01. 13:45:56 1 1000 000,00 HUF  ~
* New Template EL 05.BLC Custom deposit 2016.06.01. 13:45:59 1 5 000 000,00 HUF  ~
EL 35.8LC Custom deposit 2016.06.01. 14:33:12 1 50 000 000,00 HUF
+ Manage Templates
EL 46.BLC Custom deposit 2016.06.02. 13:51:32 1 30 000 000,00 HUF v
» Manage Partner
T PLATd > Bank status inquiry » View
+ administration
Ke HUF Transfer 2016.06.02. 15:26:20 1 10 000,00 HUF ¥
+ Settings
> Help > Back
' Logout
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Electra Internetbank user: Client: ™ JLogent

» Quick menu Custom deposit (view, Package name: EL __ _46.BLC)
' Reporting
~ Sent Packages Send date
* Order Status Account number
* Search Transaction KFTC
* New Order
* Manage Orders Amount Standard rate
HUF 5 %
+ New Template
* Manage Templates
Term deposit day Date of Expiry Term deposit mode
+ Manage Parmers - S SR
* Administration Interest account
' Settings ;
* Help » Status of order item
> B ' 00_01 Processed
» Signatures / Sent by
valid signatures Point Date of signature ?Back
» Quick menu Deposit - Search product
* Reporting
Account number Available amount
» Sent Packages 1200 KFTCS - 15: F
~ New Order
» HUF orders Amount of term deposit Number of details Term deposit mode
» Collection Orders HUF 1@ Time deposit order v
+ Group Orders
+ International Orders Term deposit day Term Date of Expiry
» Currency conversion Ll 2 B
+ Forms Product on sale
~ Deposits No v
» Deposit
» Cancel deposit Fape
* Manage Orders
In case youare fine with the offer, click on Create deposit button.
» Quick menu Deposit - Search product
*» Reporting
y Account number Available amount
Sent Packages 120 KFT CS v 1 20 152 85 HUF
~ New Order
HHUE oty Amount of term deposit Number of details Term deposit mode
» Collection Orders 1000000,00 HUF 10 Time deposit order v
> Group Orders
et Tatioaa Drders Term deposit day Term Date of Expiry
> Currency conversion ol S ook hd AL
» Forms Product on sale
¥ Deposits No v
»Deposit
» Cancel deposit ey
* Manage Orders
(@ Please select a product!
* New Template
Productname Standard rate / EBKM
» Manage Templates Corp&Public standard kamat 100 M HUF alatt - 3 hé 001% v

* Manage Partners 3 Create deposit

» Administration

After the authorisation, you can submit the order.

Raiffeisen Electra Internetbank - User Manual (20.12.2024)



6 Orders

By means of Electra Internetbank, you can submit different HUF, foreign currency, collection and
multiple orders, forms and letters. As (with the exception of forms and letters) usually more than

one orders are launched a day, Electra will make packages (files) of these, while letter type

orders are treated individually (i.e. these have to be signed and sent one by one).

A transfer order file includes items that are all the same type of orders (HUF or foreign currency
credit transfers), the number of the account to be debited is identical, and they should be sent to

the Bank on the same they. In the case of a collection order, the beneficiary account number and
the scheduled date of sending should be identical.

Upon entering an order, you can specify when (on which day) it should be sent to the Bank. The
client program will remember this data, and use it when packaging orders.

6.1Prepare Orders

Under the New orders option, select the order type.

m# Raiffeisen
BANK

Electra Internetbank

&l search menu... 7

User: User  Client: + Logeut

comeen accour [

» Quick menu
* Reporting

+ Sent Packages

* Manage Orders

» New Template

» Manage Templates
+ Manage Partners
+ Admiristration

> Settings

* Help

» Logout

HUF Transfer (creation)

Scheduled date of dispatch
20 =

HUS3 HUF GP-82

v Supplementary payer information

Creditor data

Beneficiary” s name Destination bank

>Find templatepartner > Createtemplate  >Cancel  >lmmediate dispateh > Add to package

You can finish entering the order using the Add to package button, after which the order will

be packed into a file (except for letter type orders), which can be named as you wish.

If you wish to use this order later as well, you can save it as a pattern by clicking on the Create

Template button.

Click on the OK button, and the order will be packed into the file.
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W Raiffeisen sin page . ) : lock: 09:50
BANK a 7

Electra Internetbank User: User  Client: +Logaut

Select package

(@ Please choose a package for the order,

User 201510/02 15:47:62

6.2 Instant Foreign Currency Conversation

Choose the menu point New order / Currency conversion / Instant foreign currency

conversion you can start money transfer - as an instant exchange - between your two
accounts with different currency at a competitive rate. For example, you can convert from
your HUF account to your USD account or from your EUR account to your HUF account.

Minimum amount to be converted: 1,000 HUF or equivalent currency, maximum amount: 4,000,000
HUF or equivalent currency. The minimum and maximum values can be changed centrally by the
bank. The system will warn you each time you enter an amount higher or lo wer than the current
limit.

Instant foreign currency conversion
Source account Available amount

120 v 4762 119,70 HUF

Target account Narrative
120 v

Amount
1000 000,00 HUF v

Execution

extra urgent

>Cancel > Next

Source account

The account from which the amount you have entered will be converted. Select from the dropdown
list the current account from which you wish to use the amount to be converted.

Target account

The account to which the target currency amount is credited after conversion.

Conversion amount

The amount you want to convert. This can be in the source currency or the target currency, if you
prefer.
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Scheduled date

Completion date. The date on which you want the conversion to be completed. Only the option
"Extra urgent (T)" can be selected.

Atfter filling in the form, click O c Y buttdd on the top of the screen and system will display the
actual rate at which the system will execute your order if you sign the order within 60 seconds. If

b di UdCOT HoéC TiY dGUYGY T1iY OdCLYGHodC | 04&aa
You can view the discounted exchange rate several times a day free of charge, but the

conversion will only take place if you sign the offered rate within 60 second

Instant foreign currency conversion

Source account

Target account Narrative
Credited Amount

Execution

Rafer e Remaining time 53 seconds

Debited Amount

@ If you wish to send it, authenticate with your signature:

Password

> Modify

Click Cancel to return to the main menu. After entering the password and pressing the Approve
button, confirmation will appear on the screen.

6.3 Order Management

You can change the transfer orders included in a prepared file any time before the given file is
signed; you can delete orders from the file, transfer orders into other files, or add new orders.

However, an order or order file that is already furnished with a signature may not be changed any
longer. In such case the signature should be deleted first.

1.Select the Manage Orders/Manage Packages  option.
2. Select the file to be modified, then click on the button of the operation to be executed
below the file.

6.4 Sending Message and Document to Bank

Choose menuNew order and then submenu Forms.
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Click on Send Message . Here you can write a mail in usual way and you can attach file either.
Overall 5 files can be attached to one message and size of each file must be less than 5
MByte.

If you choose Immediate dispatch  Electra forces you to authorize (sign) and then send
message to Bank on this screen.

If you choose Add to package Electra stores message in a package and you can authorize
it later.

> Quick menu Send Message (creation)
Reportng Scheduled date of dispatch
> Sent Packages 2018.04.05
Sender
~ New Order RAIFFEISEN BANK RT
> HUF orders Subject
» Collection Orders
> Group Orders
*» International Orders
» Currency conversion
~Forms

Message

» Certificates

>Banking Information

>New Business Card

> Modify Business Card

>Bankcard limit modification

»Modify Account Parameter

>Modify Statement
Generation

>Cash Withdrawal Request

>Ordering Postal Cash
Withdrawal Slip

>Modify Contact information

>»Send Message > New attachment

> Create restraint

> Delete restraint

~ Attachments

@ No attachments.

> Cancel > i i >Add to

> Deposits

6.5 First usage of Token

1. Switch on Token with button! If you do not use it till 20 seconds, the Token is switched
off.

2. On the indicator PIN is appeared.

Please type the default 4 characters PIN code, which is received from the bank!

If you make a mistake typing PIN code, on the indicator FAIL will be shown with the number of
AT1TYEgT o 1 Yém® CI M\ 3¢ C! M 35t

Lt [N

After five unsuccessful attempts the device will be disabled. If you make a mistake while enter
PIN code, the wrong number can be deleted with & button.

3. If you successful enter the PIN code, on the indicator the NEW PIN will be shown.

o)
HE\W PIN

Please enter a new PIN code, which is chosen by you. The code must have been 4 characters,
ACU o1 Hidli aUuCoOi OY tdi G gYGHdCAa UAT Ao Me
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indicator NOT SAFE will be appeared, and to change PIN code is not allowed. In this case
please chose and enter another code!

4. On theindicator PIN CONF is appeared.

]
PINCONF

Please retype the PIN code again.

5. On the indicator NEW PIN CONF is appeared.

ey
NEY PINCONF

In this case the new PIN code is inserted successful. After changing PIN code, the Token can be
used with this new PIN code!

If you make a mistake while enter PIN code, the bad number can be deleted with & button

6.6 Modification of PIN code

PIN code can be changed at any time.

1. Switch on the device and enter your PIN code!
2. Press the @ button for 3 seconds.

3. Onthe window NEW PIN is appeared.
NEV/ PIN

4. Please insert the new PIN code! On the window PIN CONF is appeared.
PINCONF

Please reenter the PIN code.

5. On the window NEW PIN CONF is appeared.
NEY PINCONF

In this case the new PIN code is inserted successful. After changing PIN code, the Token can
be used with this new PIN code.

6.6 Blocking of PIN code

If you make a mistake typing PIN code, on the indicator FAIL will be shown with the number of
AT1TYEgT o 1 Yém® C! M\ 3¢ C! M\ 31t oMe | didiledétiemnpt 17 Y
will be zero.

After five unsuccessful attempts the device will be disabled, in this case on the window LOCK
is appeared. It is not possible to enable the Token. Please call on your Account Officer to
claim new Token.
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6.7 Blocking of Token

If the Token is lost or fall into unauthorized persons hands, please call Raiffeisen Direkt call
center (06-80-488-588) or personally to your Relationship Manager.

6.8 Signing Orders with Token

To sign your orders in Electra you can choose hardware token called token.
Token

With your User ID (which was given at contracting) and the generated password by the
Token you can authenticate the orders. The bank system will check the user rights by the
Token data.

Signing with token

1. Select the Manage Orders/Manage Packages option.
2. Select the file(s) to be signed, then click
a. on the Sign Selected File button if you wish to approve the file,
b. on the Delete Selected File button if you want to remove the signature from
the file.
3. Turn on your signature device (token), and after entering your PIN code enter in the
token the series of numbers displayed in the Challenge field.
4. Type the response code provided by your signature device in the Token password
field, then click on the OK button.

» Reporting

» Sent Packages Scheduled date of dispatch

Account to be debited

Creditor data

Beneficiary' s name Destination bank

Account to be credited

» Manage Orders

> New Template

» Manage Templates Transaction information

» Manage Partners

» Administration

> Settings
» Help

End To End Identification
» Logout

Narrative / Postal Id. / Other 1D

Challenge:

Token password

Challenge

Token password 44024722

] »ox
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6.9 Signing Orders with VICA

To sign your orders in Electra you can choose software token too called VICA mobile token.

VICA mobile token (application)

The VICA is downloadable for iOS and Android smartphones, which provides safe and
independent communication between the client and the bank, without the use of other
certification device. After the registration in the VICA application, Electra will send th e
details of the signed order to your application, where you can sign it by a touch.

Registration of the VICA mobile token

Before you use VICA first time you need to register it to your Electra profile.

1. Download and install to your smartphone the VICA application (for iOS from the
App Store, for Android from the Google Play).

ViCA

Cardinal Szamitastechnikai Kft ‘
100K+ 3]

App support v

2. Open the application, and enter an individual password. Later on you have to use
this password to log in to ViCA application. Biometric authentication can be used
if the device supports fingerprint or FacelD identification.

4:
|

@ o HE
VIiCA VIiCA VIiCA

You have not registrated this appplication for
any bank yet. Before using VIiCA, please set your
unique VIiCA password! The password must be
at least 8 characters long, containing both

You have not registrated this appplication for
any bank yet, Before using VICA, please set your
unique ViCA password! The password must be

YYou have not registrated this appplication for
any bank vet. Before using ViCA, please set your
unique ViCA password! The password must be

at |east 8 characters long, containing both L > £ | at least 8 characters long, containing both
letters and at least 2 numbers.
FacelD Do you want to allow “ViCA" Message
— — Do you want 10 use Face D7 — to use Face ID? ——  Biometric identification is Ctivated
passwora strength ViCA needs permission to use FacelD
— No Yes OK
( ) [ j Don't Allow Allow ( ]
G
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/] a00A dC TiY xYeéoHT GATiodC ¢e¢YCi¢o ACU
b di 6 OACAY dgiodcCo
+ < Back Choose a bank
Registrations e
° GIRO Electra
e K&HBank
Kamn Electra Internet Banking
. KDBBank
U NetBank, PC Kontakt
MBH Bank
(korabban MKB)
UN;“NK MBH Direct Bank /
Vallalati Netbank
ax MBH Bank (korabban
M Takarék)
You have not registered yet BANK  MBH Netbank
Y OTP Bank
In order to use the VICA application for bank © OTP Electra

of
identification, you must register using the 5

password or QR code received from the bank.

Let's start

Raiffeisen Bank
Raiffeisen Electra

Unicredit Bank
Spectra

7]

Registrations

Registrations

4. On next screen you have to type your Raiffeisen Electra user IDand login

Raiffeisen Electra Internetbank

password.

Registration

X

Raiffeisen Bank

Please enter your username and the ViCA
registration password you received from the bank.

C )
( )

5. After it Raiffeisen Bank send you a code in text message (SMS) and you should

enter and send it on the next screen. With it registration was completed. (Phone
number which is used for SMS is the number you specified in your Raiffeisen
Electra Request Form)
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Signing with VICA

1. Launch the order in Electra (with any platform: Terminal, Internetbank,
Mobilebank). When the order is recorded, there will be a message on Electra
interface, to open the application .

2. Enter the application with the given password (which was given at the
registration) or use biometric identification if it has been allowed.

3. After the login, in the Messages box the given order will appear. Click on the order,
and you will be able to see the detail, and also approve it.

6.10 Sending Orders

1. Select the Manage Orders/Manage Packages option.
2. Select the file(s) to be signed, then click on the Send Selected Packages button.

Successfully sent order files are transferred and can be viewed under the option Sent
Packages

6.11 Sent Packages

The order files displayed in the Sent Packages option have been received by the Bank, and
information is sent on the status of the orders. It may happen, however, that a formally correct
file includes an order that is incorrect from the banking point of view, therefore the order is
not fulfilled (e.g. the account number of the recipient is erroneous, or the debit may not be
executed due to insufficient balance, etc.).

1. Select the Sent Packages/Order Status option.

2. Enter the desired period, then click on the OK button.
3. Select the relevant order file, then click on the Bank Status Inquiry button.
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